
 

New features of CadnaA 2022 
New features of CadnaA 2021 MR1 and MR2 can be found here. 

Configuration of Calculation 

• Rename Tab „Country“ in Tab „Standards“. In Tab Standards: 
o Removal of the country selection. The calculation methods for the noise types 

industry, road and railroad are now always selected individually (analog to 
previous country selection „user defined“)  

o „Parameter Check“ becomes „Template“, see separate section later in this 
document. 

• New calculation methods according to CNOSSOS-EU, see separate section later in this 
document. 

• Calculation method CNOSSOS-EU: Setting „Calcluation acc. to“ to define the EU-
version or a specific national implementation can now be set separately for each 
noise type in the tabs industry, road and railroad (previously: one setting for all 
bevorementioned noise types). 

• Railroad Tab (CNOSSOS-EU): New input parameter number of „Train-Barrier-
Interactions“, default value is 0.  

• Tab Road (CNOSSOS-EU): Button „Vehicle classes“ extended to selection menu. This 
now shows default vehicle classes defined in the internal default library and user-
defined entries of the local library.  

• Tab Evaluation Parameters: When using the Evaluation Parameter „DIN4109tot“ or 
„f(x)=DIN4109totd/n“ the noise type industry is now always considered with target 
value Lde, independent of the setting of other Evaluation Parameter (previously: Ld). 

• Tab Evaluation Parameters: When using the Evaluation Parameter „DIN4109tot“ or 
„f(x)=DIN4109totd/n“ the case distinction regular case/special case for the noise type 
Industry is now also carried out for the calculation in the grid (previously only for 
Receivers and Building Evaluations).  

• Tab Ground Absorption: Default value for resolution at map of ground absorption = 
1m (previously 2m) 

Building Noise Map 

• Setting „Lower Rcvr max 20cm below eave“ additionally considers that no receivers 
with a relative height < 2.0 m above ground are generated (according to BUB 2021). 



 

Calculation | Configuration | Calculation Methods (CNOSSOS-EU) 

The following calculation methods have been introduced into CadnaA to implement the 
European Directives 2015/996 and 2021/1226 and their national implementations. After 
selecting "CNOSSOS-EU" in the "Standards" Tab, the European or national implementations 
can be selected for each noise type Tab: 

• Industry: 

„Calcluation acc. to“ previously Comment 

2015/996 EU CNOSSOS-EU 
Implementation of additional 
specifications from ISO TR 17534-4, 
Version 20201 

2021/1226 EU - Implementation of the EU Directive 
2021/1226 

 

• Road 

„Calcluation acc. to“ previously Comment 
2015/996 EU CNOSSOS-EU 

Implementation of additional specifications 
from ISO TR 17534-4, Version 20201 2015/996 DE (BUB 2018) CNOSSOS-DE 

2015/996 AT (RVS 2019) CNOSSOS-AT 

2021/1226 EU - Implementation of the EU Directive 
2021/1226 

2021/1226 DE (BUB 2021) - Implementation of the national 
interpretations of EU Directive 2021/1226 
for Germany and Austria. 2021/1226 AT (RVS 2021) - 

 

• Railroad 

„Calcluation acc. to“ previously Comment 
2015/996 EU CNOSSOS-EU 

Implementation of additional specifications 
from ISO TR 17534-4, Version 20201 2015/996 DE (BUB 2018) CNOSSOS-DE 

2015/996 AT (RVE 2019) CNOSSOS-AT 

2015/996 FR (SNCF 2021) - 
Implementation of the national 
interpretations of EU Directive 2015/996 for 
France. 

2021/1226 EU - Implementation of EU Directive 2021/1226 
2021/1226 DE (BUB 2021) - 

Implementation of the national 
interpretations of EU Directive 2021/1226 
for Germany, Austria, Belgium and France. 

2021/1226 AT(RVE 2022) - 
2021/1226 BE (Infrab. 2022) - 
2021/1226 FR (SNCF 2022) - 

 
1 Existing projects saved with CadnaA 2021 MR2 (or earlier) are displayed with the addition "w/o 17534" in the 
calculation configuration when opened with CadnaA 2022. For new CadnaA files this selection option is no 
longer available. 
 



 

New Feature „Templates“ 

• CadnaA-internally defined Templates for calculation according to a specific standard, 
regulation, guideline or method, which takes into account settings of the 
Configuration of Calculation, Building Noise Map, individual Objects and Areas of 
Designated Use. A template can be selected at the following places in CadnaA:   

o Configuration of Calculation, Tab „Standards“: When a Template is selected, 
the current settings are compared with the Template and deviations are 
displayed. With a click on OK all settings of the Template are taken over into 
the project. 

o For new projects in the File menu  New (Template). A new CadnaA model 
can thus be initialized with a basic setting. The selected template is saved in 
the calculation configuration, "Standards" Tab. 

• In the menu „New (Template)“ additionall user defined CadnaA files can be used as 
templates by placing them in the installation directory in the subdirectory 
templates/new. 
This path can be customized via an entry in the INI-file (section [Main], Variable 
NewTemplateDir= „C:\example“). 

CadnaA-Objects 

• Railroad (CNOSSOS-EU): representation of emission now in 1/3-Oktave Band 
Spectrum (previously in octaves) 

• Bitmap: The feature „Choose region in browser“ upon import from Google Maps os 
mow based on the Microsoft Edge browser which is usually available by default on 
Windows systems. 

ObjectScan 

• New default entry „2021/1226, People in level classes (Median)“ for evaluation 
according to EU Directive 2021/1226 or a national interpretation. 

• New default entry „2021/1226, Noisiest grid point in/near building“ and „2021/1226, 
Quietest grid point near building“ for determining the loudest/quietest immission 
level in the grid following the procedure of the test tasks for BEB 2021. Detailed 
instructions can be found in the CadnaA Reference Manual. 

• New default entry „2020/367“: Calculation according to EU Directive 2020/367 on 
the assessment of harmful effects of environmental noise. Calculation of risk 
ischaemic heart disease (IHD), highly annoyed people (HA) or highly sleep disturbed 
people (HSD). The calculation procedure is performed in conjunction with the 
function in the Calculation | Multiple Source Effect menu. For more information, 
please refer to our reference manual. 

• Default entries reorganized with hierarchical menu. User-defined entries can also be 
stored hierarchically by specifying "\" in the name.  

• New Option „Grid Point as Rectangle“: When checking whether a grid point lies 
within an area/inside a window, the associated rectangle is used instead of the x/y 
position of the point. If rectangle and area/window intersect, the grid point is taken 
into account. 



 

• New Attributes for „Formula for Summation“ LPx_MIN8 and LPx_MAX8. With the 
help of these attributes the minimum/maximum value of the 8 neighboring grid 
points (horiz., vert., diag.) can be determined.  This function is used in connection 
with the preset „2021/1226, Quietest grid point near building “.  

Libraries 

• New library „Vehicle Classes“ for the definition of different emission parameters 
according to CNOSSOS-EU or a country-specific implementation. 

• Library „Road Surfaces“ for CNOSSOS-EU extended by the input of speed ranges. In 
addition, it can be defined whether a road surface is valid for 2015/996 and/or 
2021/1226.  

• Library-Manager: New option „Keep both“. When importing to the local / global 
library, if the ID between existing library entry/library entry to be imported is the 
same, both are kept. 

Attributes, Variables und Keywords 

• For calculation method CNOSSOS-EU, new keywords for setting „Calcluation acc. to“ 
for each noise type tab.  

o Tab Industry = CNS_ICNTRIN,  
o Tab Road = CNS_ICNTRRD,  
o Tab Railroad = CNS_ICNTRRL,  
o Tab Aircraft = FLG_ICNTRY.  

• The previous keyword ICNTRY is still valid for the setting in the Industry Tab.  
• For calculation method CNOSSOS-EU, new keyword CNS_VEHCLS for the selected 

vehicle class in the Tab „Road“. 
• For calculation method CNOSSOS-EU, new keywords CNS_VMAX_XX with XX 

indicating the vehicle class (1, 2, 3, 4A, 4B) for referencing the vehicle class-
dependent maximum speed in the "Road" Tab.  

• Keywords #(ImmValName, param1, param2) and #(ImmValUnit, param1, param2) 
extended. The name of a plot cell (in the plot designer) can now be specified as 
param2. Then evaluation parameter/unit of the plan cell is displayed. 

• Object Railroad: New Attributes:  
o RAILROUGHI: Rail roughness as Integer 
o RAILROUGH: Rail roughness as String 
o DBR_STR: Select Bridge as String 
o RAI: Select curve radius as Integer 
o SQUEAL_MEAS: Measure against curve squeal (1/0) 



 

Further Innovations 

• Menu Options |Appearance: Double click on object type in list activates / deactivates 
the display of this object type 

• Menu Tables |Variant: Double click on list object activates / deactivates this variant 
• New Lua-function cna.activate_protocol() to activate/deactivate the protocol and 

cna.get/set_weighting() read/write the weighting under Options  Miscellaneous 

Bug Fixes 

• Optimization of the function „map of ground absorption“ in the menu Calculation| 
Configuration | Tab Ground Absorption. In certain cases, the ground absorption areas 
could be incorrectly taken into account. 

• An error has been corrected when importing directivities in XHN format, where the 
values were incorrectly interpreted as level correction instead of attenuation. It is 
recommended to re-import affected directives. 

• Fixed incorrect import of barriers from *.prj-Dateien (Mithra). 

  



 

New Features of CadnaA Version 2021 MR1 + MR2 

CadnaA-Objects 

• Label: Arithmetic operations within the text field, e.g. #(ObjAtt, 02000000, LP1++LP2, 
1, 0.500) can be used to calculate the sum level of day and night. 

• Road: Road surfaces implemented according to RAL - “Richtlinien für die Anlage von 
Landstraßen“. 

• New object: CadnaB-Building for extended transmission calculations from outside to 
inside and vice versa with our new software CadnaB. 

Calculation | Configuration 

• Configuration of calculation  Tab Industry now with the following new options:  
o Obstacles within Area Sources do not reflect 
o No attenuation for sources within built-up areas 

• Configuration of calculation  Tab Industry: All settings concerning meteorology 
have been moved to a separate tab "Meteorology". 

• National interpretation of CNOSSOS-EU implemented for France and Spain. 
• FTA 18: Missing train classes added.  
• Options for CadnaB Interop: Settings regarding synchronization with CadnaB (variant, 

evaluation parameter, time of synchronization). 

Further New Features 

• Extended Undo and Redo functionality  
(e.g. editing geometry, actions via „Modify Objects“ and object tables) 

• Local/global library: Display of sound level spectra in octaves (instead of 1/3 octaves) 
possible with provided template files. Files are automatically installed in the 
installation directory. 

• Menu Options  Appearance: New buttons to copy/paste a layer including all 
defined settings. 



 

Miscellaneous 

• New attributes to define the directivity of industrial sources: DIR_PHI, DIR_PSI and 
DIR_THETA 

• Consistency Check: 
o Warning if a referenced directivity has been deleted in the directivity library.  
o Warning if "Li from interior sources" refers to a sound level spectrum that has 

been deleted. 
• Display of 1/3 octaves instead of octaves for library tables Sound Levels, Sound 

Reduction Indices and Absorptions.  
• New attribute for building evaluations LP1_STW (floor with maximum level) 

Bug Fixes 

• RLS-19: When using the guideline RLS-19, the reflection condition of RLS-90 was used 
up to now. This error has been corrected with version 2021 MR2, so that the 
reflection condition of RLS-19 is now used. A detailed explanation can be found in the 
German version of CadnaA at Help -> Contents -> CadnaA 2021 MR2 New Features -> 
Link in CadnaA. 

• When converting a traffic source to an industrial source or when using "Long Straight 
Road" conversion of sound power level corrected. 

• TNM: Screening for cylinder and self-screening corrected.  
• Land use: Incorrect assignment of land use when using "empty lines" (land uses 

without short and long name) fixed. For a detailed description, see 
Help -> Contents -> CadnaA 2021 MR1 New Features -> Link in CadnaA. 

 

 

 


	New features of CadnaA 2022
	New Features of CadnaA Version 2021 MR1 + MR2

